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Preface
The LabSolutions IR software is one component of the LabSolutions software package and is used with the 
Shimadzu's Fourier Transform Infrared Spectrophotometer series to control the instrument and perform data 
analysis.
The operation manual for the LabSolutions IR software comprises four volumes including this manual. This quick 
guide briefly introduces the LabSolutions IR software from startup through to initial operation.
For more details on usage, refer to the corresponding operation manual.

Installation and • 
Maintenance Manual

This manual explains software installation, troubleshooting, and environment 
settings.

Management Manual• This manual explains how to use the management function and validation 
software.

Basic Operation • 
Manual

This manual explains specifically how to perform basic operations using the 
software.

Quick Guide• This quick guide briefly introduces software startup through to initial operation.

Quick Guide Notation

 @@@@@
Emphasizes additional information that is provided to ensure the proper use of 
this product.

 **@@* Indicates information provided to improve product performance.

  ^ Indicates the location of related reference information.
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Postrun / View

Manipulation

Search
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2.Determining Quantities in Unknown Samples

NOTICES
If the user or usage location changes, ensure that this Instruction Manual is always kept together with the • 
product.

Information in this manual is subject to change without notice and does not represent a commitment on • 
the part of the vendor.

Any errors or omissions which may have occurred in this manual despite the utmost care taken in its • 
production will be corrected as soon as possible, although not necessarily immediately after detection.

All rights are reserved, including those to reproduce this manual or parts thereof in any form without • 
permission in writing from Shimadzu Corporation.

The contents of the hard disk of the personal computer may be lost as the result of an unforeseen accident. • 
Always create a backup to protect critical data from such accidents.

 Replacement parts for this product will be available for a period of seven (7) years after the product is • 
discontinued. Thereafter, such parts may cease to be available. 
Note, however, that the availability of parts not manufactured by Shimadzu shall be determined by the 
relevant manufacturers.

O riginal version is approved in English.• 

© 2012 Shimazdzu Corporation. All rights reserved.
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Software 
S

oftw
are 

Shimadzu offers the following three software versions in the LabSolutions IR series.
This quick guide uses the file management version of LabSolutions IR to explain operation.

LabSolutions DB IR LabSolutions CS IR

Data backup

Startup method

Standalone / network

Project management

Authorized group management

User management

CLASS-Agent database

LabSolutions database

Transferring LabSolutions IR data between 
PCs

Data management method

Data references

Edition Database edition

Measured data files are saved and managed in the LabSolutions database.
The existence of data files cannot be checked using Windows Explorer.

The software references files in the database.

Loading via import
(Data can be either copied to a local destination using the data file export function or downloaded from the database manager.)

Unavailable
(The contents of the CLASS-Agent database can be transferred to the LabSolutions database.)

Available

Performed for each database.

Available

LabSolutions icon

Available

Available
(The database resides on a local PC)

Client server edition

Available
(The database resides on a server or local PC)

File management edition

Measured data files are saved and managed in folders on the PC.
The existence of data files can be checked using Windows Explorer.

The software references files in folders or drives on the PC.

Transfer of files

Unavailable

Available (Option)

Available

Available

Unavailable

Either can be used.

Performed on a file-by-file basis using Windows Explorer.

LabSolutions IR icon, LabSolutions icon

LabSolutions IR

Only the standalone configuration can be used.

Either can be used.
(LabSolutions IR data can be viewed using the database 
manager on a PC set up for viewing purposes. Note that 

LabSolutions IR must be installed on the PC used  
for viewing.)
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Initialization2 
Check that power is supplied to the FTIR.1  
Select [Initialize].2  
A green rectangle (  ) is displayed in the status monitor.

"Initialization is succeded." is displayed in the log.

Enter a Filename  4 and Sample Information
Enter a filename.1  
Enter the sample information.2  

入入Input2

入入入入Click3 

Spectrum 

入入入入Double-click1

Startup1 

Postrun7 
Perform operations including printing, searching, and 
manipulation with respect to spectra.

See "Postrun/View" on pages 12 to 13 ^

Perform Background 5 Measurment 

Set the background sample.1  
Click [BKG Scan].2  
A background spectrum is displayed.

入入入入Click4 S
pectrum

 

This section explains the general spectrum program procedure for samples.

Set Scan Parameters3 
Click the [Data] tab.1  
Set scan parameters such as the number of 2  
scans and resolution. 

Measure the Sample6 
Click [Measurement].1  
Set the sample.2  
Click 3   .
A spectrum of the sample is displayed. 
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Continues from step 3  
in "2. Determining Quantities in Unknown Samples" 
on page 9

入入入入

入入入入

④ダブルクリック

This section explains how to create a calibration curve that is required for quantitation of unknown samples.
Calibration curve creation requires a standard sample spectrum measured using spectrum program in absorbance mode 
to be saved in advance.

入入入入Click3
入入Select5

Click8

入入入入Click4

Click7

入入入入入Enter a 
wavenumber

If a saved calibration curve 
already exists, proceed to 

step 2  in "2. Determining 
Quantities in Unknown 
Samples" on page 8

入入

Quantitation 1.Creating a Calibration Curve

入入入入Double-click1

Input1

入入Configure settings9

Create a Standard Sample 3 Table

Click [Import].1  
The [Import Spectrum] window is displayed.

Select the standard sample spectrum and click 2  
[Import].

Click [Close] to close the [Import Spectrum] 3  
window.

Enter the concentration into each row.4  

Startup1 

Set Scan Parameters6 
Click the [Scan parameters] tab.1  
Click [Settings].2  
The [Instrument Parameters] window is displayed.

Set scan parameters such as the number of scans  3  
and resolution.

Click [OK].4  

Set Calibration Curve Parameters4 
Click the [Calibration Curve] tab.1  
Click [Settings].2  
The [Edit calibration curve] window is displayed.

Set the calibration curve parameters.3  
The input procedure is shown to the right.

Click [OK].4  

Save the Calibration Curve7 
Click [Save Calibration Curve].1  
Enter a filename and click [Save].2  

1.C
reating a C

alibration C
urve

6

Q
uantitation 

Configure 
settings

Configure 
settings

2

入入Input2 

入入入入Click3 入入入入Click4 

Create a Calibration Curve5 
Click [Calibration].1  
A calibration curve is displayed.

Initialization2 
Check that power is supplied to the FTIR.1  
Select [Initialize]. 2  
"Initialization is succeded." is displayed in the log.
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入入入入

This section explains quantitation of unknown samples using calibration curves and how to calculate and assess the 
measurement results of unknown samples. A calibration curve must be measured and saved in advance.

Proceed from here when continuing from step 7  
in "1. Creating a Calibration Curve" on page 7

Click5

入入Select2 入入入入Click1

入入入入Click4

入入入入Enter an equation
3

Quantitation 2. Determining Quantities in Unknown Samples

Perform Background 5 Measurement

Set the background sample.1  
Click 2   .
A background spectrum is displayed.

Perform Quantitative Measurement 6 of the Unknown Sample

Set the unknown sample.1  
Click 2   .
A spectrum is displayed. 

When measurement is complete, concentrations are  

displayed in the unknown sample table.

Load a Calibration Curve2 
Click [Load Calibration Curve].1  
The [Open] dialog box is displayed.

Enter the filename and click [Open].2  
The calibration curve is displayed. 

Startup1 
See "Quantitation 1. Creating a  ^

Calibration Curve" on page 6

Prepare the File3 
Click 1   .
file specification dialog box is displayed.

Enter the name of the quantitative data file and 2  
click [OK].

Post-processing7 
Click the [Equation] tab.1  
Click [Edit].2  
The [Equation setting] window is displayed. 

Set an equation.3  
The procedure is shown below.

Rcalculation8 
Click [Calculation].1  
The result is updated to the unknown sample table.

Prepare the Unknown Sample 4 Table

Click [Insert Line].1  
Enter the spectrum name (mandatory) and 2  
sample information.

Selecting multiple sample cells and clicking [Edit All] 

allows collective input in the [batch sample information 

input] window.

2. D
eterm

ining Q
uantities in U

nknow
n S

am
ples

Q
uantitation
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Measure the Sample8 
Set the sample.1  
Click 2   .
When measurement is complete, the photometric results 

are displayed in the sample table.

Prepare the Sample Table6 
Click [Insert Line].1  
Enter the spectrum name (mandatory) and sample 2  
information.

Selecting multiple sample cells and clicking [Edit All] allows 

collective input in the [batch sample information input] 

window.

Perform Background 7 Measurement

Set the background sample.1  
Click 2   .
background spectrum is displayed.

Prepare the File5 
Click 1   .
A file specification dialog box is displayed.

Enter a name for the photometric data file and click 2  
[OK].

　 　 　 　1  

入入

入入入入

入入入入

Photometric 

Startup1 

Initialization2 
Check that power is supplied to the FTIR.1  
Select [Initialize].2  
"Initialization is succeeded." is displayed in the log.

Set an Equation3 
Click the [Equation] tab.1  
Click [Edit].2  
The [Equation setting] window is displayed.

Set an equation.3  
The input procedure is shown below.

入入Input2 

入入入入Click3 

Select2

Click5

Click1

入入入入Click4

Set Scan Parameters4 
Click the [Scan parameters] tab.1  
Click [Settings].2  
The [Instrument Parameters] window is displayed.

Set scan parameters such as the number of scans 3  
and resolution.

Click [OK].4  

入入入入Click4 
入入入入Double-click1

入入入入入Enter a 
wavenumber

3

P
hotom

etric 

This section explains how to scan intensity (such as absorbance and transmittance) as well as peak height and area at specified positions 
(wave numbers and wavelengths) on a spectrum. A variety of calculations can be performed using the scanned values.
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Search / Edit Library Ṳ
See "Search" on pages 16 and 17  ^

See "Library Creation and Editing" on pages 18 and 19

Zooming Spectrum  Ṳ
Drag on the graph window to create a 1  
quadrilateral.

Click the desired position to magnify.2  
The display is magnified.

**@@*
The spectrum can be zoomed in or out automatically by • 
clicking [Autoscale] on the right-click menu.

 Return the spectrum to its original size by clicking  • 
[Full view] on the right-click menu. 

Manipulation Ṳ
See "Manipulation" on pages 14 and 15 ^

　　　　

Chemometrics Ṳ
Refer to "Chapter 10 Chemometric Quantitation" in LabSolutions  ^

IR INSTRUCTION MANUAL (Basic Operation Guide)

When Performing Postrun from Measurement Programs Ṳ
@@@@@
The measurement programs that allow postrun are • 
spectrum program, time course program, and mapping 
program.

[Chemometric] and [Edit Library] cannot be selected in • 
the windows of each measurement program.入入入入Click

Drag and drop the red line onto the loading position.3  
The coordinate values of the point are displayed in the point 

pick table.

Click to confirm.4  

Peak Pick Ṳ
Click the [Peak Pick Table] tab.1  
Click 2   at the lower left and select [Auto Cursor].
A red line is displayed in the graph window.

Drag and drop the red line onto the loading position.3  
Peak point data is displayed in the peak table.

Click to confirm.4  

Postrun / View

入入入入Double-click1

Startup1 

Print / Print Preview Ṳ
Data can be printed using the specified report 
template.

**@@*
When printing with a report template,  • 
click [Print Preference] on the [Tool] menu.

When printing with a different report template,  • 
click [Print with Template] on the [File] menu.

View Print / View Print Preview Ṳ
Select the information for printing in the [Viewprint 
Settings] window.

Postrun  2 
Display data for postrun.

入入入入

入入Input2 

Click3 入入入入Click4 

P
ostrun / V

iew

 Joining Ṳ
Click [Join All] on the [Window] menu.1  
All currently displayed data is shown in an overlaid state.

This section explains the functions for displaying data, peak pick, zooming data on screen,and overlaying data on the vertical axis.

Point Pick Ṳ
Click the [Point Pick Table] tab.1  
Click 2   at the lower left and select [Cursor].
A red line is displayed in the graph window.
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Difference Spectrum Ṳ
Select the target spectrum from the tree view.1  
Click [Send to Source] on the right-click menu.2  
Select the reference spectrum from the tree 3  
view.

Click [Send to Reference] on the right-click 4  
menu.

The selected spectra appear overlaid.

Select [Subtract 2 data] under [Method].5  
Click [Calc].6  
The result of calculation is displayed.

Click [OK].7  
The result of calculation of the spectra is saved.

This section explains how to perform manipulation for peak pick and difference spectra.
For details on other manipulation, refer to "Chapter 8 Manipulation" in LabSolutions IR INSTRUCTION MANUAL (Basic Operation Guide). ^

Manipulation

入入入入入入入入入入入入入入入入入
入入入

入入入入入入入入入入入入入入入入入
入入入

Click here to calculate 
 a difference spectrum

Manipulation2 
Peak Pick Ṳ

Set the peak pick parameters on [Parameter].1  
Click [Calc].2  
The result of peak pick is displayed.

Preparation1 
Display the spectrum required for manipulation in 1  
the display window for the relevant measurement 
program or postrun window.

**@@*
The measurement programs that allow manipulation 

are spectrum program, time course program, and 

mapping program.

Display the relevant 2  manipulation window.

入入入入入入
入入入入入入入入入入入入

入入入入入入
入入入入入入入入入入入入

Click here  
to detect peaks

M
anipulation



16 17

Search

Preparation1 
Display the spectrum to be searched 1  
in the display window for the relevant 
measurement program or postrun window.

**@@*
The measurement programs that allow searching 
are spectrum program, time course program, and 
mapping program.

入入Select2

入入入入Click 1

Display the search window.2  

Close7 
Click [Close].1  
Return to the search window.

Click [View].2  
Search exits.

Subtraction Ṳ
Click [Difference Factor] to calculate the difference 
spectrum of the search target spectrum and the 
spectrum selected in the hit list.

Adjust the factor.1  
Click [Done].2  
The difference spectrum is saved to the spectrum.

**@@*
Return to the original search results display by 

clicking [Join] or [Difference Factor] again.

Select a Library2 
Click the [General] tab and click [Add].1  
The [Select Libraries] window is displayed.

Select a file and click [Open].2  
The library is added to the list.

Select an Algorithm3 
Click the [Spectrum] tab.1  
Select [DiffDerive] or [CorrDerive] from the 2  
[Algorithm] list.

Execute the Search4 
Click [Spectrum Search].1  
The search results are displayed.

Post-Search Processing5 
Join Ṳ
Click [Join] to display the search target spectrum 
overlaid with the spectrum selected in the hit list.

Saving6 
Click [Fix search result].1  
The search results are saved.

S
earch

This section explains how to search for the spectrum.
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Display the [Edit Library] window.2  

This section explains how to insert spectra to a library. This allows searching of spectra inserted in the library.

入入Select2

Library Creation and Editing

Preparation2 
Display the spectrum to be inserted 1  
to a library.

Adding a Spectrum Ṳ
Select a spectrum from the tree view.1  
Click [Insert into Library] on the right-click menu.2  
A message is displayed.

Click [Yes].3  
The selected spectrum is added to the spectrum list.

Deleting a Spectrum Ṳ
Select the spectrum for deletion in the spectrum list.1  
Click [Delete] on the right-click menu.2  
A message is displayed.

Click [Yes].3  
The selected spectrum is deleted from the spectrum list.

Editing a Spectrum Ṳ
Double-click on the spectrum for editing in the spectrum list.1  
A message is displayed.

Click [Yes].2  
The [Edit Spectrum Information] window is displayed.

Click [OK] after editing is complete.3  
The spectrum is updated in the spectrum list.

Edit the Library4 
@@@@@
Commercial libraries cannot be edited.

Startup1 
See "Postrun / View" on page 12 ^  

入入入入Click 1

Library C
reation and E

diting

Create a Library3 
Select [New].1  
The [Create User Library] window is displayed.

Enter information for the library and click [OK].2  
A new edit library window is displayed.
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入入入入Click3

Print5 
Select [Print Preview].1  
The print preview window is displayed.

Select [Print]  in the print preview window.2  
The [Print] window is displayed.

Set each item and click [OK].3  
**@@*
Select [Print] in the edit print format window when 

printing without checking the output using print 

preview.

Report Template Creation

 Check Properties3 
Click on an item in the report layout window to 
display information on the item in the properties 
window.

Display the edit print format window.2  
Prepare Data1 
Display the data for printing in the relevant 1  
measurement program window or postrun 
window.

Select an Item2 
Drag and drop the selected item  1  
into the report window.

Move the cursor to adjust the size 2  
 and then click.

Adjust the overall layout.3  
**@@*
Items in the report layout window can be moved by • 
dragging them. 

Items can be enlarged or reduced by dragging a • 
point on the frame that contains them in the report 
layout window.

Drag and drop

Select

入入入入Click

R
eport Tem

plate C
reation

Select the item 
for allocation

Select the item 
  for allocation1

入入入入入入入入入入入入Select the file for allocation
2

入入入入Click 4

Registration4 
Printing can be made easier by registering created 
report templates in advance.

Click [Print Preferences] on the [Tool] menu.1  
The [Print Preference] window is displayed.

Register the report template.2  
The registration procedure is shown to the right.

This section explains how to arrange LabSolutions IR data and information in order to create a template for printing.
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Registration5 
Easy macros can be registered to the following location.

Launcher Ṳ

Click launcher's 1   icon.
The [Configuration] window is displayed.

Click the [Macro] tab and click [Add].2  
The [Edit Macro] window is displayed.

Enter a title, comment, and filename and click [OK].3  
The macro is added to the list.

Click [OK].4  
The macro is allocated to a launcher button.

Postrun Main Toolbar Ṳ
Start the postrun program.1  

See "Postrun / View" on page 12 ^

Click 2   under [Easy Macro] and select [Add Macros].
The [Macro List] window is displayed.

Click [Add].3  
The [Macro] window is displayed.

Enter a macro name and filename and click [OK].4  
The macro is added to the macro list.

Click [OK].5  
The macro is allocated to a registered macro button on the main toolbar. 

This section explains how to arrange a sequence of operations in order beginning with LabSolutions IR startup and register the sequence 
as a macro program.

Execution6 
The following procedure explains execution  
from the launcher.

Click the launcher icon.1  
The [Macro Execute] window is displayed.

Click [run].2  

Easy Macros

入入入入Double-click1
入入入入Click4 

Startup1 

Select Macro Items2 
Drag and drop command items into the edit macro 
sequence window in the order of execution.

@@@@@

Always start the sequence with [Program Start] and end 

the sequence with [Program End].

**@@*

 is displayed at the insertion position after a second 
item is added.

Drag and drop

入入Input2 

Saving4 
Select [Save as].1  
The [Save As] dialog box is displayed.

Enter a filename and click [Save].2  

Select

E
asy M

acros

Macro Sequence Check3 
Click [Check].1  
The [Information] window is displayed.

Click [OK].2  

入入入入Click3 
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